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TIN HỌC SAO VIỆT

CHƯƠNG 1: MỤC TIÊU KHÓA HỌC
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Sau khi hoàn thành khóa học, học viên có thể tự tin soạn thảo đầy đủ các loại văn bản 

thường gặp trong công việc, bao gồm:

● Bảng báo giá, phiếu đề xuất, bảng kế hoạch.
● Hợp đồng đơn giản (dịch vụ, mua bán, cộng tác…).
● Thông báo, công văn nội bộ, thư mời, quyết định.
● Biểu mẫu hành chính: biên bản họp, phiếu thu–chi, mẫu đăng ký.
● Báo cáo Word có chèn hình, bảng, tiêu đề,...
● Tài liệu in ấn: đơn từ, form mẫu, ấn phẩm trình ký.
⟹ Tóm lại: học viên có thể tự tạo mọi loại văn bản phục vụ hành chính – văn phòng từ 
cơ bản đến chuyên nghiệp.
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CHƯƠNG II: THAO TÁC CƠ BẢN VỚI TỆP TIN WORD

Bài 01: Mở và lưu tệp tin Word

I. Mục đích nghiên cứu
II. Nội dung nghiên cứu
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Việc đầu tiên khi học phần mềm nào cũng phải biết mở và lưu dự án mới. Vì vậy chương 
này cũng sẽ tập trung vào cách mở một tệp tin Word mới, lưu một tệp tin Word mới.

I. MỤC ĐÍCH NGHIÊN CỨU
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Bài 01: Mở và lưu tệp tin Word
1. Mở tệp tin Word mới

Cách 1: Nhấn phím Windows + R → Gõ “winword” → OK → “Blank document”

Cách 2: Sử dụng chức năng tìm kiếm của Windows

Windows + S → Gõ từ tìm kiếm “Word” → Chọn phần mềm Word → Blank document

II. NỘI DUNG NGHIÊN CỨU
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2. Lưu Tệp Tin Word Mới
File → Save As → Chọn Browse → Chọn nơi lưu → Đặt tên → Chọn “Save”

⇒ Lưu ý: Đặt tên đúng chính tả tiếng Việt (chữ đầu viết hoa, danh từ riêng viết hoa…) 
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CHƯƠNG III: TÙY CHỈNH TRƯỚC KHI SOẠN THẢO

Bài 02: Đơn vị tính thước đo
Bài 03: Lề giấy
Bài 04: Khoảng cách dòng đoạn
Bài 05: Font chữ

I. Mục đích nghiên cứu
II. Nội dung nghiên cứu
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Chương này giúp học viên thiết lập bố cục và định dạng cơ bản của văn bản trước khi bắt 
đầu soạn thảo, đảm bảo tài liệu được trình bày đúng chuẩn, dễ đọc và chuyên nghiệp. 
Sau khi học xong, học viên có thể:
✓ Chọn đúng đơn vị đo, thuận tiện cho việc căn chỉnh.
✓ Thiết lập lề giấy theo tiêu chuẩn hành chính.
✓ Điều chỉnh khoảng cách dòng–đoạn giúp văn bản thoáng và dễ theo dõi.
✓ Lựa chọn và đồng bộ font chữ phù hợp cho toàn bộ tài liệu.

I. MỤC ĐÍCH NGHIÊN CỨU
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Bài 02: Đổi Đơn Vị Tính Thước Đo
File → Options → Advanced  → Display  → Show…unit of  (chọn Centimeter).

II. NỘI DUNG NGHIÊN CỨU
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Bài 03: Thiết Lập Lề Giấy
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Một văn bản khi in ra sẽ đẹp 
hơn và phục vụ công tác lưu 
trữ tốt hơn khi có các lề phù 
hợp.
👉Layout → Page Setup → 
Left: 3cm (lề trái)
Right: 1.5cm (lề phải)
Top: 2cm (lề trên)
Bottom: 2cm (lề dưới)
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Bài 04: Căn Chỉnh Khoảng Cách Dòng Đoạn
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Một văn bản dễ hiểu khi có các đoạn dễ nhận biết, và các 
dòng cách nhau một khoảng cách dễ nhìn.
👉Chọn toàn bộ văn bản → Layout → Paragraph → 
Before: 6pt (khoảng cách đoạn hiện tại với đoạn trước)
After: 6pt (khoảng cách đoạn hiện tại với đoạn sau)
Line spacing : Single (khoảng cách giữa các dòng)
👉Nhớ bỏ dấu tích chọn tại mục: Don’t add space 
between paragraphs of the same style
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Bài 05: Font Chữ

TIN HỌC SAO VIỆT                            ✍Bạch Xuân Hiến           ☏ 093 11 44 858               🌍tinhocsaoviet.com            Trang 13

Trong soạn thảo văn bản bằng tiếng Việt, việc chọn font chữ và cỡ chữ phù hợp sẽ 
giúp văn bản dễ đọc và đẹp hơn.
👉Chọn toàn bộ văn bản → Home → Font →
Loại Font: Time News Roman, Kích cỡ Font: 13
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CHƯƠNG IV: SỬ DỤNG CÁC CÔNG CỤ ĐỊNH DẠNG CƠ BẢN

Bài 06: Công cụ định dạng font chữ và căn chỉnh lề

I. Mục đích nghiên cứu
II. Nội dung nghiên cứu
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Để văn bản trở nên đẹp, dễ hiểu và có điểm nhấn, cần định dạng Font chữ và căn lề
phù hợp.

I. MỤC ĐÍCH NGHIÊN CỨU
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Bài 06: Công cụ định dạng Font chữ
I. Nhóm công cụ định dạng Font chữ

Định dạng font chữ tạo ra điểm nhấn cho văn bản, từ đó sẽ trở nên được chú ý hơn.
Căn lề giúp nội dung được rõ ý hơn, giúp đoạn văn dễ hiểu và bố cục văn bản đẹp hơn
👉 Chọn văn bản → Home → Chọn các công cụ sau:

① in đậm (B)    ② in nghiêng (I)       ③ gạch chân (U)        ④ tô sáng (Highlight)  
⑤ màu chữ       ⑥ chọn nhanh in hoa, in thường                  ⑦ xóa định dạng

II. NỘI DUNG NGHIÊN CỨU
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II. Nhóm công cụ căn lề cho nội dung văn bản

①

②

③

④
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Căn trái

Căn giữa

Căn phải

Căn đều hai bên
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CHƯƠNG V: KIẾN THỨC CƠ BẢN VỀ VĂN BẢN

Bài 07: Chính tả và trình bày văn bản

I. Mục đích nghiên cứu
II. Nội dung nghiên cứu
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Một văn bản chuyên nghiệp khi:
● Viết đúng chính tả;
● Sử dụng dấu câu đúng quy định;
● Trình bày bố cục rõ ràng.
👉Tuyệt đối không được trình bày tùy tiện, sẽ làm văn bản mất thẩm mỹ và cá nhân 
người trình bày sẽ bị đánh giá là người thiếu chuyên nghiệp.

I. MỤC ĐÍCH NGHIÊN CỨU
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Bài 07: Chính tả và trình bày văn bản

Trong soạn thảo văn bản, việc viết đúng chính tả và trình bày văn bản chuẩn thể hiện sự 
chuyên nghiệp và tôn trọng người đọc văn bản. Lưu ý một số trường hợp cơ bản sau:

I. Một số quy tắc chính tả cần biết khi soạn thảo văn bản

1. Viết hoa đầu câu, sau dấu chấm câu (.), sau dấu chấm hỏi (?), sau dấu chấm than (!)

Ví dụ: Mỗi người chúng ta sinh ra đều có giá trị to lớn. Ai cũng phải nỗ lực học tập để 
nâng cao giá trị bản thân, nhưng phải chăng đó là suy nghĩ của bạn? Suy nghĩ của bạn chỉ 
có bạn mới biết. Ôi thôi! Đừng có suy nghĩ nữa, hãy hành động đi.

2. Viết hoa danh từ riêng chỉ tên người và tên địa danh

Ví dụ: Nguyễn Anh Thư, Lê Văn Bảy… thành phố Hà Tĩnh, tỉnh Bình Dương. 
Trừ 2 trường hợp đặc biệt là: Thành phố Hồ Chí Minh, Thành phố Hà Nội.

Xem tiếp trang sau
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3. Tên các ngày lễ, ngày kỷ niệm lớn
Ví dụ: ngày Quốc khánh 2-9, ngày Quốc tế Lao động 1-5, ngày Phụ nữ Việt Nam 
20-10,…
4. Tên các thứ trong tuần, các tháng trong năm (nếu không dùng số)
Ví dụ: thứ Hai, thứ Ba, tháng Hai, tháng Mười…
5. Tên các ngày tết và tên các năm âm lịch
Ví dụ: tết Nguyên đán (hoặc viết tắt là: Tết), tết Đoan ngọ, tết Trung thu…, Kỷ Tỵ, 
Tân Hợi, Mậu Thân…
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II. Trình bày văn bản đúng cách
1. Sử dụng Enter
Phím Enter chỉ sử dụng để kết thúc một đoạn văn bản hoàn chỉnh, nếu chưa kết thúc đoạn 
mà muốn xuống dòng thì phải dùng Shift + Enter.
2. Sử dụng khoảng trắng
Giữa các từ chỉ dùng một dấu khoảng trắng để phân cách. Không sử dụng dấu khoảng 
trắng đầu dòng cho việc căn chỉnh lề.
3. Sử dụng các loại dấu văn bản
Các dấu ngắt câu như chấm (.), phẩy (,), hai chấm (:), chấm phẩy (:), chấm than (!), hỏi 
chấm (?) phải được gõ sát vào từ đứng trước nó, tiếp theo là một dấu khoảng trắng nếu 
sau đó vẫn còn nội dung.
Các dấu mở ngoặc và mở nháy đều phải được hiểu là ký tự đầu từ, do đó ký tự tiếp theo 
phải viết sát vào bên trái của các dấu này. Tương tự, các dấu đóng ngoặc và đóng nháy 
phải hiểu là ký tự cuối từ và được viết sát vào bên phải của ký tự cuối cùng của từ bên 
phải.
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CHƯƠNG VI: CHÈN VÀ XỬ LÝ HÌNH ẢNH

Bài 8: Chèn hình ảnh
Bài 9: Định dạng hình ảnh
Bài 10: Một số thao tác với hình ảnh

I. Mục đích nghiên cứu
II. Nội dung nghiên cứu
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Trong quá trình soạn thảo văn bản, hình ảnh đóng vai trò quan trọng trong việc minh 
họa và làm rõ nội dung, giúp văn bản trở nên sinh động và chuyên nghiệp hơn. Vì vậy, 
việc nắm vững kỹ năng chèn và xử lý hình ảnh trong Word là cần thiết đối với người học 
tin học văn phòng.

I. MỤC ĐÍCH NGHIÊN CỨU
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Bài 8: Chèn hình ảnh
Bước 1: Đặt dấu nháy chuột tại vị trí cần chèn ảnh
Bước 2: Chọn thẻ Insert
Bước 3: Tại nhóm Illustration, chọn Picture
Bước 4: Chọn This Device
Bước 5: Tại hộp thoại mở ra, chọn ảnh → Insert 

II. NỘI DUNG NGHIÊN CỨU

TIN HỌC SAO VIỆT                            ✍Bạch Xuân Hiến           ☏ 093 11 44 858               🌍tinhocsaoviet.com            Trang 25



TIN HỌC SAO VIỆT

Bài 9: Định dạng hình ảnh
Bước 1: Chọn hình → Picture Format
Bước 2: Chọn các định dạng mong muốn
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(1) Tạo khung viền
(2) Hiệu ứng

(3) Kiểu định dạng mẫu
(4) Chọn độ sáng tối cho hình
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Bài 10: Một số thao tác với hình ảnh
1. Thay đổi kích thước và kiểu hiển thị trong văn bản
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(1) Kéo để tăng giảm kích thước theo 2 hướng

- Giữ thêm Ctrl để tăng giảm theo 4 hướng

- Giữ thêm Shift để giữ nguyên hình dạng ban đầu

(2) Xoay tròn hình

(3) Tăng giảm kích thước hình theo chiều ngang

(4) Tăng giảm kích thước hình theo chiều dọc

(5) Vị trí hiển thị hình trong văn bản

Xem tiếp trang sau
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2. Di chuyển hình ảnh: Chọn viền ngoài (xuất hiện chùm mũi tên) → Kéo và thả

3. Xóa: Chọn viền ngoài (xuất hiện chùm mũi tên) → Nhấn phím Delete (hoặc nhấn 
phím Backspace).

4. Nhóm các hình thành 1 khối

Chọn các hình cần nhóm (Giữ Ctrl + kích chuột vào hình) → Chuột phải vào 1 hình → 
Group → Group (bỏ nhóm thì chuột phải vào hình bất kỳ → Group → Ungroup)

5. Nhân bản: Chọn hình → Giữ phím Ctrl và di chuyển chuột sang vị trí khác

6. Sắp xếp lớp các hình (hình nằm trên hoặc nằm dưới hình khác)

Chọn hình → Chọn một trong các cách sắp xếp sau:

⇨ Send to Back (Sắp xếp nằm dưới hình khác)

⇨ Bring to Front (sắp xếp nằm trên hình khác)
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CHƯƠNG VII: CHÈN VÀ XỬ LÝ HÌNH DẠNG

Bài 11: Chèn hình dạng
Bài 12: Định dạng hình dạng
Bài 13: Một số thao tác với hình dạng

I. Mục đích nghiên cứu
II. Nội dung nghiên cứu
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Trong quá trình trình bày văn bản, các hình dạng (Shapes) giúp làm nổi bật nội dung, 
tạo điểm nhấn và hỗ trợ minh họa thông tin một cách trực quan hơn. Việc sử dụng đúng 
và linh hoạt các hình dạng sẽ giúp văn bản trở nên khoa học, sinh động và chuyên 
nghiệp.

I. MỤC ĐÍCH NGHIÊN CỨU
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Bài 11: Chèn hình dạng
Bước 1: Vào thẻ Insert → Chọn Shape
Bước 2: Chọn hình cần vẽ
Bước 3: Giữ chuột trái và kéo thả cho đến khi được hình mong muốn

II. NỘI DUNG NGHIÊN CỨU
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Bài 12: Định dạng hình dạng
1. Định dạng cho hình dạng
Bước 1: Chọn hình dạng: Chọn ngay viền ngoài, xuất hiện chùm mũi tên thì mới chọn
Bước 2: Chọn thẻ Format, sau đó chọn các định dạng mong muốn.
(1) Shape fill: Chọn màu cho toàn bộ hình dạng
(2) Shape outline: Viền kẻ ngoài của hình dạng
(3) Shape style: Mẫu có sẵn
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Xem tiếp trang sau
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● Shape fill: Chọn màu cho toàn bộ hình dạng
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Xem tiếp trang sau
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● Shape outline: Viền kẻ ngoài của hình dạng
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Xem tiếp trang sau
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● Shape style: Mẫu có sẵn
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2. Viết chữ và chỉnh sửa vào hình dạng
Bước 1: Nháy chuột phải vào hình dạng
Bước 2: Chọn Add text (hoặc Edit Text)
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Hoặc
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Bài 13: Một số thao tác với hình dạng
1. Di chuyển hình dạng: Chọn viền ngoài (xuất hiện chùm mũi tên) → Kéo và thả
2. Xóa: Chọn viền ngoài (xuất hiện chùm mũi tên) → Nhấn phím Delete (hoặc nhấn 

phím Backspace).
3. Nhóm các hình thành 1 khối
Chọn các hình cần nhóm (Giữ Ctrl + kích chuột vào hình) → Chuột phải vào 1 hình → 
Group → Group (bỏ nhóm thì chuột phải vào hình bất kỳ → Group → Ungroup)
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Xem tiếp trang sau
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4. Nhân bản: Chọn hình → Giữ phím Ctrl và di chuyển chuột sang vị trí khác
5. Sắp xếp lớp các hình (hình nằm trên hoặc nằm dưới hình khác)
Chọn hình → Chọn một trong các cách sắp xếp sau:
(1) Bring to Front (sắp xếp nằm trên hình khác)
(2) Send to Back (Sắp xếp nằm dưới hình khác)
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CHƯƠNG VIII: SỬ DỤNG BẢNG BIỂU

Bài 14: Tạo bảng biểu trong Word
Bài 15: Căn chỉnh vị trí và kích thước của bảng trong Word
Bài 16: Thao tác với dòng/ cột trong bảng
Bài 17: Thao tác cơ bản với ô trong bảng
Bài 18: Một số thao tác khác thường dùng để định dạng bảng

I. Mục đích nghiên cứu
II. Nội dung nghiên cứu
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Trong soạn thảo văn bản, bảng biểu là công cụ quan trọng giúp trình bày dữ liệu một 
cách khoa học, rõ ràng và dễ theo dõi. Việc sử dụng thành thạo bảng biểu giúp người 
soạn thảo tổ chức thông tin tốt hơn, làm cho báo cáo và tài liệu trở nên chuyên nghiệp 
và dễ hiểu.

I. MỤC ĐÍCH NGHIÊN CỨU
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Bài 14: Tạo bảng trong word
Bước 1: Đặt dấu nháy chuột tại vị trí cần tạo bảng
Bước 2: Vào thẻ Insert → Table → Insert Table
Bước 3: Tại hộp thoại mở ra, chọn số dòng và số cột → OK 

II. NỘI DUNG NGHIÊN CỨU
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Bài 15: Căn chỉnh vị trí và kích thước của bảng trong Word
1. Di chuyển hoặc co giãn toàn bảng

2. Giãn dòng/ cột
Di chuyển con trỏ chuột vào đường kẻ dưới của dòng hoặc đường kẻ bên phải của cột 
→ xuất hiện dấu mũi tên (như hình dưới) → Giữ chuột trái và kéo
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Bài 16: Thao tác cơ bản với dòng/ cột trong bảng

1. Xóa dòng/ cột
Chuột phải vào 1 ô → Delete Cell → 
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2. Thêm dòng/ cột
Chuột phải vào 1 ô → Insert → 
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3. Nhắc lại dòng tiêu đề
Khi bảng nằm qua trang khác, chúng ta nên 
nhắc lại dòng tiêu đề
B1: Quét chọn dòng tiêu đề → Chuột phải → 
Table Properties
B2: Tại hộp thoại hiển thị → Chọn thẻ Row 
→ Tích chọn mục: “Repeat as header row at 
the top…”
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Bài 17: Thao tác cơ bản với ô trong bảng
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1. Chèn / xóa ô trong bảng
Chuột phải vào ô cần xóa → Delete Cell → 

2. Gộp nhiều ô thành 1 ô
Quét chọn các ô cần gộp → Chuột phải
→ Merge cells

Xem tiếp trang sau



TIN HỌC SAO VIỆT

3. Tách 1 ô thành nhiều ô
Chọn ô cần tách → Chuột phải → Split Cell → Chọn số dòng và cột muốn tách
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4. Căn chỉnh nội dung trong ô
Chọn ô → Table Layout → Chọn kiểu định dạng tại nhóm Alignment
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5. Tô màu nền cho ô
Chọn ô → Thẻ Home → Tại nhóm Paragraph → Shading → Chọn màu
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Bài 18: Đánh số tự động và sắp xếp dữ liệu trong bảng
1. Đánh số thứ tự tự động

Khi đánh STT tự động, nếu xóa đi 1 dòng hay 1 cột bất kỳ, STT sẽ được tự động đánh lại
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B1: Chọn các ô cần đánh STT
B2: Thẻ Home
B3: Công cụ Numbering
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2. Sắp xếp dữ liệu trong bảng
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B1: Chọn 1 ô trong bảng
B2: Home
B3: Sort
B4: Chọn cột cần sắp xếp
B5: Chọn kiểu sắp xếp
B6: OK
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CHƯƠNG IX: KỸ NĂNG IN ẤN

Bài 19: Hộp thoại in và thiết lập trang in trong Word

I. Mục đích nghiên cứu
II. Nội dung nghiên cứu
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In ấn là bước cuối cùng nhưng vô cùng quan trọng trong quá trình soạn thảo văn bản. 
Một văn bản dù được trình bày đẹp đến đâu nhưng in sai trang, sai khổ giấy hoặc bố cục 
bị lệch cũng sẽ làm giảm tính chuyên nghiệp. Vì vậy, nắm vững kỹ năng in ấn trong 
Word giúp người dùng xuất bản tài liệu chính xác, đúng yêu cầu và tiết kiệm thời gian.

I. MỤC ĐÍCH NGHIÊN CỨU
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Bài 19: Hộp thoại in và thiết lập trang in trong Word
Để mở hộp thoại in, ta chọn File → Print (1) (hoặc nhấn Ctrl + P)

II. NỘI DUNG NGHIÊN CỨU
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(2) Lệnh in
(3) Số bản in
(4) Chọn máy in
(5) Trang cần in

- In tất cả thì để trống, phía trên để “Print All Pages”
- In 1 trang duy nhất thì có 1 trang, ví dụ: 4 (hoặc 4-4)
- In liên tục bất kỳ thì gõ trang đầu - cuối, ví dụ: 3-5
- In nhiều trang khác nhau, ví dụ: 3,7,10

Xem tiếp trang sau



TIN HỌC SAO VIỆT

TIN HỌC SAO VIỆT                            ✍Bạch Xuân Hiến           ☏ 093 11 44 858               🌍tinhocsaoviet.com            Trang 54

(6) In kiểu 1 mặt hoặc 2 mặt
- One sided: 1 mặt
- Both sided: 2 mặt

(7) Hướng giấy in (ngang/ dọc)
(8) Khổ giấy (A4, A5, Letter,...)
(9) Chuyển trang in khác
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CHƯƠNG X: SỬ DỤNG AI TRONG SOẠN THẢO VĂN BẢN

Bài 20: Ứng dụng AI trong soạn thảo văn bản

I. Mục đích nghiên cứu
II. Nội dung nghiên cứu
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Trong thời đại công nghệ 4.0, trí tuệ nhân tạo (AI) trở thành công cụ hỗ trợ mạnh mẽ 
trong công việc văn phòng. Đặc biệt, Chat GPT giúp người dùng soạn thảo văn bản 
nhanh hơn, chính xác hơn và tiết kiệm rất nhiều thời gian cho các tác vụ như viết báo 
cáo, tạo đề mục, chỉnh sửa câu chữ hay định dạng nội dung. Việc hiểu và sử dụng đúng 
cách Chat GPT sẽ giúp nâng cao năng suất và chất lượng của tài liệu văn bản.

I. MỤC ĐÍCH NGHIÊN CỨU
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Bài 20: Ứng dụng AI trong soạn thảo văn bản
Tìm kiếm “ChatGPT” → Chọn Website Chatgpt.com → Chọn đăng nhập cùng Google

II. NỘI DUNG NGHIÊN CỨU
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http://chatgpt.com
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BÀI TẬP ỨNG DỤNG
I. Soạn thảo Email và soạn thảo văn bản cùng AI

Đoạn chat mới
1. Ra lệnh cho GPT viết Email xin việc như thế nào
2. Viết giúp tôi một email xin việc cho vị trí Kế toán tại công ty ABC
3. Ngắn gọn hơn một chút nữa
Đoạn chat mới
1. Là một luật sư chuyên nghiệp, hiểu biết luật lao động mới nhất và các luật liên 

quan đến người lao động trong doanh nghiệp, bạn hãy soạn thảo một mẫu hợp đồng 
lao động chuẩn

2. Cho ví 
3. dụ cụ thể luôn
4. Hãy xuất ra tệp văn bản Word đúng bố cục, quy chuẩn văn bản hành chính Việt 

Nam

TIN HỌC SAO VIỆT                            ✍Bạch Xuân Hiến           ☏ 093 11 44 858               🌍tinhocsaoviet.com            Trang 58



TIN HỌC SAO VIỆT

II. Lập kế hoạch công việc cùng AI
Đoạn chat mới
1. Là một giám đốc kinh doanh chuyên nghiệp, hãy lập giúp tôi một bản kế hoạch 

kinh doanh cho năm mới
2. Cho ví dụ cụ thể với mảng kinh doanh trà sữa
3. Cho thêm ít mẫu bảng và các sơ đồ thể hiện kế hoạch
Đoạn chat mới
1. Là một trưởng phòng kế hoạch may mặc, hãy lập cho tôi một mẫu kế hoạch công 

việc cho cả phân xưởng trong ngày.
2. Hãy xuất ra file Word
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